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Experiment HH-2: Exercise, the Electrocardiogram, and Peripheral Circulation

Background

The arterial system functions as a pressure reservoir. Blood enters via the heart and exits through the 
capillaries. Signals from the autonomic nervous system control the tone of smooth muscle sphincters 
around the arterioles. In this way, the autonomic nervous system can control the distribution of blood to 
the various organs in the body. The distribution of blood that flows to a particular organ is influenced 
by local conditions. If there are cells that require arterial blood, due to a decline in pH or oxygen levels 
or an increase in carbon dioxide levels, smooth muscle sphincters open to permit blood into particular 
capillary beds.

At rest, the distribution of blood to a particular organ may be very different from that seen during 
exercise. For example, the blood flow to the gut decreases during exercise, while blood flow to the 
skeletal muscles increases dramatically. Furthermore, the amount of blood flowing around the 
circulatory system may be increased several fold. In this laboratory you will record the 
electrocardiogram from a (healthy) subject. The ECG will be recorded when the subject is at rest and 
immediately after exercise.

Warning: This experiment involves exercise and an elevation of heart rate. It should not be performed 
by anyone who is not healthy or has a personal or family history of cardiovascular or respiratory 
problems.
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Experiment HH-2: Exercise, the Electrocardiogram, and Peripheral Circulation

Equipment Required

PC or Mac Computer

USB cable

IX-BIO4 or IX-BIO8 USB data recorder 

Three ECG electrode lead wires

FT-220 Hand dynamometer or hand exerciser

Alcohol swabs

Disposable ECG electrodes

IXTA Setup

Use the USB cable to connect the computer to the USB port on the IX-BIO. 

Start the Software

1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is 
not available, click on the Windows Start menu, move the cursor to All Programs and then to 
the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window 
will appear as the program opens. There will be a message indicating that LabScribe has 
recognized the IX-BIO.

2. On the Main window, pull down the Settings menu and select Load Group.

3. Locate the folder that contains the settings group, IXBIO.iwxgrp. Select this group and click 
Open.

4. Pull down the Settings menu again. Select the Exercise-ECG-Circulation settings file in Human 
Heart.

5. After a short time, LabScribe will appear on the computer screen as configured by the Exercise-
ECG-Circulation settings.

6. For your information, the settings used to configure the LabScribe software and the IX-BIO unit 
for this experiment are programmed on the Preferences Dialog window which can be viewed by 
selecting Preferences from the Edit menu on the LabScribe Main window.

7. Once the settings file has been loaded, click the Experiment button on the toolbar to open any 
of the following documents:

• Appendix
• Background
• Labs
• Setup (opens automatically)
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ECG Cable Setup

1. Locate the red, black, and green electrode lead wires (Figure HH-2-S1).

2. Insert the connectors on the red, black, and green electrode lead wires into the matching sockets 
on the IX-BIO.

3. Instruct the subject to remove all jewelry from their wrists and ankles.  Another option is to use 
the area just under each clavicle which will give a better recording.

4. Use an alcohol swab to clean and scrub a region with little or no hair, on the inside of the 
subject’s right wrist/clavicle. Let the area dry.

5. Remove a disposable ECG electrode from its plastic shield, and apply the electrode to the 
scrubbed area on the wrist or under the clavicle.

6. Repeat Steps 6 and 7 for the inside of the left wrist/clavicle and the inside of the right ankle or 
lower right abdomen.

Figure HH-2-S1: The IX-BIO4 with three lead wires and electrodes connected.

7. Snap the lead wires onto the electrodes, so that:

• the red (+1) lead is attached to the left wrist or just under the left clavicle,

• the black (-1) lead is connected to the right wrist or just udner the right clavicle,

• the green (C or ground) lead is connected to the right leg or on the abdomen.
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8. Instruct the subject to sit quietly with their hands in their lap. If the subject moves, the ECG 
trace will move off the top or bottom of the screen. If the subject moves any muscles in the arms  
or upper body, electromyograms (EMGs) from the muscles will appear on the ECG recording 
as noise.
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Experiment HH-2: Exercise, the Electrocardiogram, and Peripheral Circulation

Exercise 1: The ECG in a Resting Subject

Aim: To measure the ECG in a resting individual.

Procedure

1. Click on the Record button, located on the upper right side of the LabScribe Main window 
(Figure HH-2-L1). The signal should begin scrolling across the screen.

Note: If the user clicks the Record button and there is no communication between the iWorx unit and 
computer, an error window will appear in the center of the Main window. Make sure the iWorx unit is 
connected to the USB port of the computer. Click OK and select the Find Hardware function from the 
LabScribe Tools menu. 

2. Click on the AutoScale All button in the LabScribe toolbar. Your recording should look like 
Figure HH-2-L1. 

• If the signal on the ECG is upside down when compared to trace in Figure HH-2-L1, 
click on the downward arrow to the left of the channel title and select the Invert 
function. The trace should now look similar to the one in the figure

• If a larger ECG signal is required, the electrodes should be moved from the wrists to the 
skin below each clavicle.

3. When you have a suitable trace, type <Subject’s Name> Resting ECG in the Mark box to the 
right of the Mark button. Press the Enter key on the keyboard to attach the comment to the data. 
Record for a minute or two.

4. Click Stop to halt recording. 

5. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 
in which to save the file, like your lab group folder. Designate the file type as *.iwxdata. Click 
on the Save button to save the data file.
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Figure HH-2-L1: ECG and heart rate displayed on the Main window. 

Exercise 2: The ECG After Leg Exercises

Aim: To measure the ECG immediately after exercise using the leg muscles.

Procedure

1. While the subject is resting, disconnect the snap leads from the subject.   If you choose you can 
also disconnect the leads from the IX USB device.

2. If you choose to disconnect the leads, coil up the lead cables so the subject can hold them in his 
or her hand while exercising with the leg muscles, like walking stairs or gently jogging in place. 
Remember that the lead wires are still attached to the electrodes, so the free portion of the 
cables need to be long enough to allow the subject to move easily, yet short enough that the 
subject does not trip.

3. Instruct the subject to exercise for three minutes. Immediately after the exercise period is over, 
have the subject sit down and relax next to the recording equipment.

4. Quickly reconnect the cables or leads. 

5. Click on the Record button. Click AutoScale All on the LabScribe toolbar. While recording, 
type ECG-Recovery from Exercise in the Mark box to the right of the Mark button. Press the 
Enter key on the keyboard to attach the comment to the data. 

6. Continue recording until the subject’s heart and breathing rates have returned to normal. This 
may take less than 2 minutes, or longer than 10 minutes, depending on the fitness of the subject. 
Enter marks and comments on the recording at 30 second intervals by typing comments on the 
Mark line and clicking on the Mark button or pressing the Enter key on the keyboard.

7. Click Stop to halt recording.
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8. Select Save in the File menu on the LabScribe window.

Data Analysis

Use the following techniques to analyze the data from Exercises 1 and 2. The information extracted 
from these exercises will demonstrate the effects of exercise and recovery on heart or pulse rate.

1. Scroll through the recording and find a section of data with four or five exemplary ECG cycles 
recorded in succession while the subject was resting.

2. Use the Display Time icons to adjust the Display Time of the Main window to show at least 
four complete ECG cycles on the Main window. Four adjacent ECG cycles can also be selected 
by:

• Placing the cursors on either side of a group of four complete ECG cycles.

• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the 
segment with the four selected ECG cycles to the width of the Main window.

3. Click on the Analysis window icon in the toolbar (Figure HH-2-L2) or select Analysis from the 
Windows menu to transfer the data displayed in the Main window to the Analysis window 
(Figure HH-2-L4).

Figure HH-2-L2: The LabScribe toolbar.

4. Look at the Function Table that is above the uppermost channel displayed in the Analysis 
window. The names of the mathematical functions used in the analysis, V2-V1 and T2-T1, 
appear in this table. The values for V2-V1 and T2-T1 from each channel are seen in the table 
across the top margin of each channel. 

5. Once the cursors are placed in the correct positions for determining the amplitudes and the time 
intervals on each ECG cycle, the values of these amplitudes and time intervals can be recorded 
in the on-line notebook of LabScribe by typing their names and values directly into the Journal, 
or on a separate data table.

6. The functions in the channel pull-down menus of the Analysis window can also be used to enter 
the names and values of the parameters from the recording to the Journal. To use these 
functions:

• Place the cursors at the locations used to measure the amplitudes and time intervals of 
the ECG cycle.
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• Transfer the names of the mathematical functions used to determine the amplitudes and 
time interval to the Journal using the Add Title to Journal function in the ECG Channel 
pull-down menu.

• Transfer the values for the amplitudes and beat period to the Journal using the Add Ch. 
Data to Journal function in the ECG Channel pull-down menu.

7. Use the mouse to click on and drag the cursors to specific points on the ECG/Pulse recording to 
measure the following:

• The R-wave amplitude. To measure the R wave amplitude, place one cursor on the Q wave that 
precedes the R wave and the second cursor on the peak of the R wave. The value for V2-V1 on 
the ECG channel is this amplitude (shown in Figure HH-2-L3). Measure the amplitudes of two 
additional R waves.

• The beat period, which is the time interval between two adjacent R waves (Figure HH-2-
L3). To measure the beat period, place one cursor on the peak of an R wave and the 
second cursor on the peak of the adjacent R wave. The value for T2-T1 on the ECG 
channel is the beat period. Measure the beat period for two additional pairs of R waves.

Figure HH-2-L3: An ECG trace recorded in the Main window with labels to indicate the points used to  
determine the four time values to be measured during data analysis. Cursors indicate the points used to  
determine R-amplitude.

• The P-R interval. To measure this time interval, place one cursor at the beginning of the 
P wave and the second cursor at the beginning of the QRS complex. The value for T2-T1 
on the ECG channel is the P-R interval. Measure this time interval for two additional 
ECG cycles.
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• The Q-T interval. To measure this time interval, place one cursor at the beginning of the 
QRS complex and the second cursor at end of the T wave. The value for T2-T1 on the 
ECG channel is the Q-T interval. Measure this time interval for two additional ECG 
cycles.

• The T-P interval. To measure this time interval, place one cursor at the end of the T wave 
and the second cursor at the beginning of the P wave. The value for T2-T1 on the ECG 
channel is the T-P interval. Measure this time interval for two additional ECG cycles.

8. Calculate the following values and type your results into the Journal or on a separate data table:

• The average R-wave amplitude.

• The average beat period, in seconds/beat.

• The heart rate, which is expressed in beats per minute and calculated from the average 
beat period by using the following equation:

Heart Rate (beats/minute) = 60 seconds/minute
                         # seconds/beat

Note: Heart Rate can also be determined by looking at the Mean function on the Heart Rate Channel. 
The more data on screen - the more accurate the Mean heart rate.

• The average P-R interval.

• The average Q-T interval.

• The average T-P interval.

9. Scroll through the recording and find a section of data with four or five exemplary ECG cycles 
recorded in succession when the subject just stopped exercising (Recovery time = 0 seconds). 
Repeat Steps 2 through 7 for this section of data. 

10. Move to the sections of data marked at 30 second intervals throughout the recovery period 
began and repeat the measurements performed in Steps 2 through 7.

Questions

1. How does the heart rate from the subject at rest and at 0, 30, 60, 90, and 120 seconds after 
exercise (recovery) compare? If there is any variation between the rates for each time period? Is 
there a trend and what is it?

2. How does the average P-R interval from rest and each time period in recovery compare? Do 
you see any variation or trend?

3. How does the average Q-T interval from rest and each time period in recovery compare? Do 
you see any variation or trend?

4. How does the average T-P interval from rest and each time period in recovery compare? Do you 
see any variation or trend?
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5. How does the average R-wave ECG amplitude from rest and each time period in recovery 
compare? Do you see any variation or trend?

Exercise 3: The ECG After Hand Exercises

Aim: To measure the ECG immediately after exercise.

Procedure

1. Instruct the subject to sit quietly with their hands in their lap.

2. Make sure the ECG lead wires are connected to the electrodes.

3. Grasp the dynamometer or a hand exerciser in the palm of one hand.

Note: The FT-220 hand dynamometer is not plugged into the iWorx unit at this time. The FT-220 is 
being used as the resistance against which the hand muscles do some work.

4. Rhythmically squeeze the dynamometer bulb for three minutes or until the forearm muscles 
fatigue.

5. Immediately after the subject stops squeezing the hand dynamometer, click on the Record 
button. Click AutoScale All on the LabScribe toolbar. While recording, type ECG-Recovery 
from Hand Exercise in the Mark box to the right of the Mark button. Press the Enter key on the 
keyboard to attach the comment to the data. Record for three minutes or until the amplitude of 
the finger pulse signal has attained a reasonably constant level for one minute.

6. Click Stop to halt recording.

7. Select Save in the File menu.

Data Analysis

Use the techniques used in Exercises 1 and 2 to determine:

• The heart rate from the subject at rest and at 0, 30, 60, 90, and 120 seconds into the 
recovery period from hand exercise

• The average R-wave amplitude for rest and each time period of recovery.

Questions

1. How do the heart rates for rest and each time period of recovery from hand exercise compare?

2. How do the heart rates from the leg and the hand exercise compare? Does one type of exercise 
cause a higher heart rate than the other?

3. Do the R-wave amplitudes from the hand exercise differ from the same values from the leg 
exercise?
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